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INTRODUCTION 
 
This introductory level course is aimed at those who want to learn how to create 
a database using Microsoft Access 2010.  You will create a simple relational 
database, input a small amount of data into the tables, and retrieve specific 
information from the database. 
 
 
Knowledge assumed  

 experience of using a computer, for example keyboard  
and mouse familiarity 

 experience of using Windows 

 experience of using the Office 2010 ribbon 

 
 
Areas covered  

 creating a table 

 entering data 

 relationships 

 creating queries 

 creating simple forms 

 producing simple reports 

 
 
 
European Computer Driving Licence (ECDL) 
 
If you are undertaking the ECDL Database unit, this document covers all of the 
assessment objectives. 
 
You may also like to enrol for the on-line training for ECDL which is available 
through your Blackboard account.  For enrolment information, contact the IT 
Training Office on (0116) 257 7160. 
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Document signposts 
 
 
 
Instructions for you to type  

 Bold text 
 

 
 
Shortcuts  

 

 
 

Reminders  

  
 
 

 
 
Notes  

  
 

 
 
 
Exercises  
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DATABASE CONCEPTS 
 
WHAT IS A DATABASE? 

 
A database is defined as an organised collection of related data.  It can be 
regarded as an electronic filing system that can hold thousands, even millions, of 
items of information. 
 
As you design the tables that hold the data, you specify what type of data will 
be stored, for example, a date, text, number etc. 
 
The huge advantage of a database is that, once the data has been entered, you 
can query it to extract information in seconds rather than the hours it might 
take you if it were stored in a manual system. 
 
Creating a really effective relational database is a job for an expert.  This course 
does not aspire to those levels, but will provide you with sufficient expertise to 
produce the kind of database that you might find useful for saving information 
for inclusion in a report or mail merge. 
 
 

HOW IS A DATABASE ORGANISED? 

 
A database is organised into tables, records, and fields. 
 
A table is a collection of data about a specific topic, such as course delegates or 
equipment.   Using a separate table for each topic means that you store that 
data only once.  This results in a more efficient and flexible database and 
reduces the possibility of data-entry errors.  A database may consist of one or 
many tables. 
 
Tables organise data into columns (called fields) and rows (called records). 
 
For example, each record in a ‘course delegates’ table will contain all the 
information about an individual delegate, such as ID number, last name, first 
name, department etc.  Each field in that table contains the same type of 
information for each delegate, such as last name.  A field should only contain 
one element of data. 
 
A query is used to extract and analyse data. 
 
A report is a way to present and print selected information. 
 
A form is used to view, enter and edit data in the database in a format that is 
more convenient and user-friendly than a table. 
 
A relationship is a link between information in one table and information in 
another table. 
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WHAT IS A PRIMARY KEY? 

 
In order to set up a relationship between two tables and show how information 
in one relates to information stored in the other, you need to identify a field in 
one of the tables where the data will be unique for every record. 
 
This field is called the key field or primary key field and is usually referred to as 
the primary key. 
 
 

WHAT IS AN INDEX? 

 
When a field is set to be indexed, the database attaches an indexing structure to 
the field; this makes it quicker to perform searches on the field. 
 
The primary key of a table is automatically indexed.   
 
You should be aware that Access updates all of its indexes every time you add or 
update a record.  Because of this, you should ensure that you only use indexes 
where you really need to, otherwise you will find the entering and editing of 
data slows down considerably. 
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PLANNING AND DESIGNING A DATABASE 
 
Before you create a database you must give it a lot of thought and make a plan 
as to how you will construct it.  There are obviously some questions you need to 
ask: 

 Why do I need this database?  What will I use the data for? 

 Is there an existing database that I could use? 

 What data is to be included and should it be split into several related tables? 

 How will the data be divided into fields, and will any of these contain a 
unique value that could be used as a primary key field? 

 What will the data types be:  text, numbers, currency, etc? 

 What properties am I likely to define for each field when I am creating the 
tables? 

 How will the tables be related? 

 What forms, queries and reports will I need? 
 
A very important point to remember is that, while data entered in separate 
fields can always be brought together again in a report, data entered in a single 
field cannot be split. 
 
For example, if you input a person’s title, first name or initial, and last name in 
a single field, say Mrs Joanna Smith, the data will always be displayed in that 
form.  You cannot decide later that you would like to use individual components, 
say Joanna or Smith on their own. 
 
It is advisable to have three separate fields (title, first name, last name) which 
you can join together in various combinations:  Mrs Joanna Smith, Mrs Smith, 
Joanna Smith, Dear Joanna, or Dear Mrs Smith. 
 
 

RELATIONAL DATABASES 

 
As you determine the purpose of the database, a list of information you want 
from it will begin to emerge. 
 
When you plan the database, you will no doubt start by listing all of the fields 
that you need to store the data.  If it is a very simple database, you can 
probably manage with a single table. 
 
However, if you try to fit a more complex database into just one table, you will 
find that you are repeating some of the data. 
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For example, you might set up a database to record the courses that students 
are enrolled on.  It is reasonable to assume that many students will be enrolled 
on each course.  If you have a single table, you will be endlessly repeating the 
course details for each student.  It is much better to have two tables:  one for 
the course details, and one for the student details.  You then create a 
relationship between the tables. 
 
If you have two or more tables linked by a relationship, you must have a field in 
each table that holds information that can be used to create the relationship.  
One of these fields must be a primary key field which means that the 
information it holds is unique for each record.   
 
In the example below, the course number field will be used to make the 
relationship between the tables.  The primary key field will be in the Course 
information table.  This is because each course in the Course information table 
will have a unique course number.  The course number will not be unique in the 
Student information table, because you can expect many students to be on the 
same course. 
 

 
 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

Do bear in mind that data in some databases is not suitable for a relational 
database, and you have no alternative but to use a single table ‘flat’ database. 

Two records relating 
to this course 

Student information 

 
Title 
First name 
Last name 
Address 1 
Address 2 
Town 
Telephone number 
Date of birth 
Driving licence y/n 
Course number 
 

Course information 
 
Course number 
Course title 
Room number 
Course leader 
Module credits 
Minimum number of students 

 

Course record 

Student information 

 
Title 
First name 
Last name 
Address 1 
Address 2 
Town 
Telephone number 
Date of birth 
Driving licence y/n 
Course number 
 

Many records but only 
one per course 
 

Many student records  
per course 
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The database you are about to create contains information about students and 
courses.  Course data will be the same for many students, so the database will 
have two related tables, one containing student details and the other containing 
information about the courses. 
 
The table of student details will contain the information listed below: 
 
 

Title: Mr 
First Name: Francis 
Last Name: Tresham 
Address 1: 56 Parliament Street 
Address 2: Fulham 
Town: London 
Telephone Number: 2987009 
Date of Birth: 05-Nov-1953 
Driving Licence: Yes 
Course Number: PT765800 

 
 
 
 
 
The table of course details will contain the following information: 
 
 

Course Number: PT765800 
Course Title: Advanced Pyrotechnics 
Room Number: S5.8 
Course Leader: Guido Fawkes 
Module Credits: 5 
Minimum Number of 
Students: 

15 

 
 
 
 
 
 

  

Ten 
fields 

 

Sample 
data 

Six 
fields 

 

Sample 
data 
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NAMING CONVENTION 

 
It is always a good idea to use descriptive names when naming aspects of the 
database.  Very long names should be avoided however, because they may result 
in typing errors when you need to refer to them later. 
 
Access 2010 allows the use of names that include spaces, but this can cause 
problems if, in future, you decide to enhance your database with Visual Basic for 
Applications (VBA) modules.  It is therefore advisable not to include spaces when 
naming any aspect of the database. 
 
When choosing descriptive names it is sometimes necessary to have more than 
one word in the name.  Most database developers use either the underscore 
character between the words, or capitalise the initial character of the second 
and subsequent words in order to make it readable. 
 
In this training document the second method is used, so the ‘first name’ field in 
the student details table will be given the field name firstName. 
 
It is also useful for the name of a database object to give an indication of the 
type of object that it is associated with.  Many database designers therefore add 
a three letter prefix to the name to specify the type of object that it is. 
 
This training guide uses the following prefixes: 
 

Object Prefix 

Table tbl 

Query qry 

Form frm 

Report rpt 

 
So, for example, the table of course details will be called tblCourses. 
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CREATING A RELATIONAL DATABASE 
 
You are going to create a relational database. 
 
 Double click the Access 2010 shortcut icon on the Desktop   

Or 
 
 Click the Start button   

 All Programs 

 Microsoft Office 

 Microsoft Access 2010 

The Access opening screen is displayed. 
 

 
 
 
To start a new blank database: 
 
 Ensure that Blank Database is selected from the Available Templates 
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The pane on the right of the window shows the location and file name of the 
database being created. 
 
A filename is automatically assigned, but you can change it. 
 

Access requires a filename before you begin to construct the database. 

 
 

 
 
 
The database that you are creating will be called Students1 and is to be saved 
in the AccessIntroduction folder on drive C. 
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To change the location and file name: 
 
 Click into the File Name text box and replace the default filename with 

Students1 

 Click the Browse icon next to the File Name text box   

The File New Database dialog box is displayed. 
 

 
 
From the navigation pane on the left select: 
 
 Local Disk (C:) 

 
 
 Select the AccessIntroduction folder 

 Click Open 

 Click OK to accept that folder as the location for the database 
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The following file name and location should now be seen in the right pane of the 
Getting Started window. 
 

 
 
 Click Create 

When a database is created a table opens in ‘datasheet’ view with the default 
name Table1. 
 
 
 
 

 
 
 
 
 

Quick Access 

Toolbar 

Ribbon 

tabs 

Help 

The 
Ribbon 

Navigation 
pane 

Views 
shortcuts 

Status 
bar 

Main section 
showing Table1 

In datasheet view 
 

Field 

names 
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SAVING A NEW TABLE 

 
You will use Table1 for the student details information. 
 
To save the new table with an appropriate name: 
 
 Click the Save button on the Quick Access Toolbar 

 In the Save As dialog box that appears, overwrite the default table name 
with tblStudentDetails 

 
 
 Click OK 

 

ADDING FIELDS TO A TABLE 

 
To prepare the table to receive your data you must now add the required fields 
to the table using appropriate field names. 
 
The two possible views for a table are design view and datasheet view. 
 
Design view is used to alter the design of the table, which includes adding and 
editing fields and setting the properties of the fields. 
 
Datasheet view is used to view and edit the data contained in the table.  This 
version of Access has made it possible to alter some aspects of the table design 
in datasheet view in order to make the creation of simple tables more user-
friendly. 
 
Adding fields in datasheet view 

 
The first field was added to the table automatically and named ID.  The next 
five fields to be added are: title, firstName, lastName, address1, and address2. 
You will use datasheet view to set up these fields in the table. 
 
To create the field named title: 
 
 Click the Click to Add heading at the top of the table 

 

Click here 
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A list of options is displayed. 
 

 
 
You use this list to select the type of data that will be stored in the new field. 
 
 Click Text 

A new field is added to the table with the default name ‘Field1’ highlighted. 
 

 
 
 Type title 

 Press the Tab key to go to the next field (or click on Click to Add) 
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 Select Text as the data type 

 Type firstName as the name of the field 

 
 
 Continue the process to add the next three field names: lastName, address1 

and address2 

 When the last field name is added click in the row below the field names to 
exit from the field naming process 

 
Adding fields in design view 

 
To switch to design view: 
 
 Ensure that the Home tab is selected 

 Click the Design View icon in the Views group of commands   

The table is shown in design view. 
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The remaining field names are: town, telephoneNumber, dateOfBirth, 
drivingLicence, and courseNumber.  You will use design view to add these fields 
to the table. 
 
In the Field Name column you enter the names of the fields you want to create. 
 
 Click into the first empty row in the Field Name column 

 
 
 Type town 

 Press the down arrow key to go to the next field name 

 Type telephoneNumber 

 Continue the process to add the last three fields: dateOfBirth, 
drivingLicence, and courseNumber 
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Data types 

 
When setting up a table you need to indicate what type of data will be stored in 
each field. 
 
Observe the Data Type column and see that all the fields that you have added 
have been given a Text data type.  This is the default data type and will usually 
be correct for most fields.  A text field can hold both alphabetic and numeric 
data. 
 

Data Type Uses 

Text Use for text, or text and numbers 
that are not used in calculations. 
Up to 255 characters. 

Memo Use for text greater than 255 
characters, or for text that uses 
rich text formatting. 

Number Use for storing numbers to be used 
in calculations, except for 
monetary values. 

Date/Time Use for storing date/time values. 

Currency Use for storing monetary values. 

Auto Number Use for generating unique numeric 
values automatically that can be 
used as a Primary key. 

Yes/No Use for fields that can hold one of 
two values. 

OLE Object Use for storing images and objects 
from other Microsoft applications. 

Attachment Use for images, objects and files. 
This new data type is more flexible 
than the older OLE Object, and is 
expected to slowly take its place. 

Hyperlink Use for storing hyperlinks to web 
pages and files. 

Lookup Wizard This is not actually a data type, but 
is used to create a combo box to 
look up values stored in another 
table. 

 
 
In your present table, the data in the dateOfBirth field will be a date and for the 
drivingLicence field you will use a tick box to indicate whether or not the 
student has a licence.  You will therefore need to change the data type for these 
two fields, but the text data type is suitable for all the others. 
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 Click into the Data Type column for the dateOfBirth field 

 Click the down arrow in the Data Type box 

A list of the available data types is displayed. 
 

 
 
 Select Date/Time from the list 

 Change the Data Type for the drivingLicence field to Yes/No 

The completed list of fields and their data types: 
 

 
 
  

Data types 

available 
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Field properties 

 
Each field in a table has a set of properties that determine how the data is 
entered or displayed.  For example, numeric data may need to be displayed to 
three decimal places, while dates may need to be shown in a specific format. 
 
The field properties are displayed in the bottom pane of the design window.  
The properties you are offered are dependent upon the data type that you 
choose for the field. 
 
Defining field properties allows you to control what data will be accepted in the 
field, and how information is entered and displayed. 
 
It is not necessary to change the properties for every field, but you should set a 
property if it helps to validate information entered in the table, or if it helps to 
make the database easier to use. 
 
 Click into the Data Type column of the title field 

The properties for this field are shown in the bottom pane. 
 

 
 
 
Text field sizes are set to 255 characters by default, but you can set it to any 
value between 0 and 255.  You use the field size property to restrict the number 
of characters that a field will accept.  It is sometimes a good idea to limit the 
size to the value equal to the largest number of characters you expect to store 
in the field. 

Field Properties 
for the  

selected field 
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 Change the Field Size to 3 

To restrict the data that can be entered into a field, you can create a validation 
rule. 
 
 Click into the Validation Rule row in the field properties 

 Type the text Mr or Mrs or Ms 

 Press Enter 

Access automatically adds quotation marks to the text items. 
 

 
 
You can use the Validation Text property to add text that will be displayed if 
the database user violates the Validation Rule. 
 
 In the Validation Text row type the text Must be Mr or Mrs or Ms 
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The Caption property is used to set the heading or label for the field in forms, 
reports and datasheet view of the table.  If the property is not set, the field 
name will be used for the heading or label. 
 
It is good practice to use the Caption property to set user-friendly headings and 
labels for fields with complex field names. 
 
The title field does not have a complex field name, but you will set the Caption 
property using upper case for the initial character. 
 
 In the Caption row type Title 

By default, the Required property is set to No.  This allows the user to leave this 
field empty when completing a record.  To ensure that the title field cannot be 
left empty you will change the property. 
 
 Click into the Required row 

A down arrow appears to the right of the text box 
 

 
 
 Click the down arrow 

 
 
 Choose Yes from the options listed 

 
The Default Value property enables you to set a value for the field that Access 
will enter automatically in each new record. 
 
 In the Default Value row type Mr 

 Press Enter 

Quotation marks are automatically added to the text. 
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The Indexed property creates a hidden index for the field.  Although this 
inevitably makes the database bigger, it speeds up the process of searching for 
specific values in that field. 
 
 Click into the Indexed row 

 Click the down arrow on the right of the property box 

The following options are displayed. 
 

 
 
Yes (No Duplicates) will create an index and will not allow two different records 
to have the same value in this field. 
 
Yes (Duplicates OK) will create an index that will accept the same value in 
multiple records. 
 
You will not index the title field. 
 
 Select No to leave the property unchanged 

 
 For the other fields in the table, set the properties according to the following 

list and save the changes before continuing 

Field name Data type Field 
size 

Caption Format Indexed 

ID AutoNumber  Student ID   

firstName Text 15 First Name   

lastName Text 15 Last Name  Yes 
(Duplicates 
OK) 

address1 Text 30 Address line1   

address2 Text 30 Address line2   

town Text 20 Town   

telephoneNumber Text 11 Telephone 
Number 

  

dateOfBirth Date/Time  Date of Birth Medium 
Date 

 

drivingLicence Yes/No  Driving 
Licence 

  

courseNumber Text 8 Course 
Number 

  

 
 Save the changes to the table 
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To switch to datasheet view: 
 
 Ensure that the Design tab is selected 

 Click the Datasheet View icon in the Views group of commands  

 
The table is displayed in datasheet view: 
 

 
 

Notice that the field headings are no longer taken from the field names but are 
now taken from the caption properties. 

Don’t worry that you cannot read the full heading for some of the fields, we will 
address that later. 
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CREATING A NEW TABLE 

 
You will now create a second table to hold the course information. 
 
 Select the Create tab 

 Click Table Design from the Tables group of commands   

A new table is opened in design view. 
 

 
 
 
 Create the following fields with the properties as listed 

 Field name Data type Field size Caption  

 courseNumber Text 8 Course Number  

 courseTitle Text 30 Course Title  

 roomNumber Text 6 Room Number  

 courseLeader Text 20 Course Leader  

 
The final two fields of this table will hold numeric data. 
 
 Add a new field with name moduleCredits 

 Assign it the data type Number 
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The default field size is Long Integer.  An integer is a whole number – no decimal 
places.  If the data that you are going to enter into a field needs to display 
decimal places, you must change the field size.  If you do not, Access will 
automatically round the numbers up or down and only store the rounded values. 
The decimal values will therefore be lost. 
 
 Click into the Field Size property 

 Click the down arrow to see the available options 

 
 
 Select Single (this allows decimal places, see page 118) 

 Click into the Format property and click the down arrow to see the available 
options 

 
 
Formats affect the way data is displayed, not how it is entered or stored in the 
table. 
 
 Select General Number 

By default the Decimal Places property is set to Auto.  This means that the 
numbers will be displayed as specified in the Format property.  (See page 118 
for more information about number formats.) 
 
 Click into the Decimal Places property and click the down arrow 

 Select 1 
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 Set the Caption property to Module Credits 

 
 
 
 Add a new field name minimumStudents 

 Assign it the data type Number 

 Change the field size property to Integer 

 Set the caption to Minimum Number of Students 

 
You have finished entering the details of the design. 
 
 Click the Save button on the Quick Access Toolbar 

 Replace the table name with tblCourses in the Save As dialog box 

 
 
 Click OK 

Access reminds you that a primary key has not been defined and asks if you 
would like to create one. 
 

 
 
You will cancel the saving process while we discuss setting up a primary key. 
 
 Click Cancel 
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Setting the primary key field 

 
A relational database contains two or more tables that are related to each 
other.  In order to have a relationship between two tables, one of the fields that 
define the relationship must be a primary key field.  Remember that a primary 
key field holds unique information. 
 
Think about the two tables you have just created.  In each table you have 
included a field named courseNumber.  In the courses table the courseNumber 
field will contain ‘unique’ data since each course has a different number.  This 
will therefore be set as the primary key field in the courses table and used to 
make the relationship with the students table. 
 
The fields used in the relationship need not have the same name but the field 
properties must be the same. 
 
You have already seen that, when you save a table for the first time, if you have 
not set a primary key, Access will remind you that you should consider specifying 
one. 
 
That reminder dialog box gives you three options: 
 
Option What it means What it does 

Yes Allow Access to do it for 
you 

Access cannot recognise which of the fields 
should be a primary key, so it will add an 
AutoNumber field at the top of the table 

No Tell Access that you do 
not want a primary key 
in this table 

Saves the table without a primary key 

Cancel Cancel the saving 
process 

Takes you back to the table design so that 
you can select the field to be used as the 
primary key 

 
 
To set the primary key field for the courses table: 
 
 Ensure that the Design tab is selected 

 Click onto the courseNumber field 

 Click the Primary Key button in the Tools group of commands   

A key symbol is displayed next to the field name. 
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The primary key of a table is automatically indexed.  Notice that the Indexed 
property for the courseNumber field is set to Yes (No Duplicates). 
 
 Save the table using the name tblCourses 

To close this table: 
 
 Click the right mouse button on the tblCourses tab 

 
 
 Select Close from the displayed shortcut menu 

 Close tblStudentDetails table 

Both tables could be closed simultaneously by selecting Close All from the 
shortcut menu. 
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MAKING THE RELATIONSHIP 

 
Once you have created the tables in the database, you need to instruct Access 
how to bring the information in those tables together.  The first step in this 
process is to define relationships between the tables.  You will then be able to 
create queries, forms, and reports to display information from several tables at 
once. 
 
To create the relationship between tblStudentDetails and tblCourses: 
 
 Select the Database Tools tab 

 Select Relationships from the Relationships group of commands 

Since this is the first time that you are creating a relationship in this database, 
the Show Table dialog box is displayed automatically to enable you to add the 
required tables to the relationship window. 
 

 
 
 
 Ensure that tblCourses is selected in the Show Table dialog box 

 Click Add to add this table to the Relationships window 

 Select tblStudentDetails 

 Click Add 

 Close the Show Table dialog box 
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Both tables with their respective fields are now displayed in the Relationships 
window. 
 

 
 
 
To create the relationship, you need to see the courseNumber field in both 
tables. 
 
 Use the scroll bar on the tblStudentDetails table to move down the list until 

the courseNumber field is visible 

Or 
 
 Drag the bottom edge of the tblStudentDetails table down so that you can 

see all of the field names 

 

 
 
 Hold down the mouse button over the courseNumber field in tblCourses, drag 

the mouse pointer to the courseNumber field in tblStudentDetails, then 
release the mouse button 
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The Edit Relationships dialog box is displayed showing the tables and fields that 
have been selected. 
 

 
 
You have the following options: 
 
Enforce Referential Integrity 
 
By selecting this option you ensure that data in the related fields is the same. 
For example, a student may be enrolled on a course only if there is a matching 
record in tblCourses. 
 
Selecting this option also ensures that you cannot delete a course from 
tblCourses if tblStudentDetails contains records referring to that course. 
 
Cascade Update Related Fields 
(Available only if Enforce Referential Integrity is checked.) 
 
If you choose this option, changing the value in the courseNumber primary key 
field will result in related records in tblStudentDetails being updated 
automatically. 
 
Cascade Delete Related Records 
(Available only if Enforce Referential Integrity is checked.) 
 
With this option selected, if you delete a record in tblCourses, the related 
records in tblStudentDetails will also be deleted.  Before choosing this option 
you should give it some serious thought. 
 
 
 Ensure that the Enforce Referential Integrity box is ticked 
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Relationship types 

 
The Relationship Type is shown at the bottom of the dialog box. 
 
There are four relationship types: 
 

 One-to-one 

 One-to-many 

 Many-to-one 

 Many-to-many 

 
To create a one-to-one relationship each of the fields used to define the 
relationship must be a primary key field. 
 
Because courseNumber is the primary key field in just one of the tables, a one-
to-many relationship is created.  This is the most commonly used relationship. 
 
In this database it will mean that: 
 

 A record in tblCourses can have many matching records in 
tblStudentDetails 

 A record in tblStudentDetails can match only one in tblCourses 

 In other words, many students can enrol on the same course, but each 
student can enrol on only one course 

 
 Click Create 

You may get the following message: 

 

This warning message is displayed if at least one of the tables being linked is 
open. 

●  If you see this message, click OK 

●  Click Cancel to close the Edit Relationships dialog box 

●  Close the table(s) 

●  Then Create the relationship as described above 
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Notice the relationship line linking the two tables with the courseNumber fields. 
 

 
 

The 1 at the tblCourses end of the line and the ∞ symbol at the 

tblStudentDetails end of the line confirm that this is a one-to-many relationship, 
and that for any one record in tblCourses, this relationship will allow many 
student records to contain a matching value. 
 
To edit a relationship after it has been created: 
 
 Click the relationship line between the two tables to select it – when 

selected it will be emboldened 

 Select Edit Relationships from the Tools group on the Design tab 

The Edit Relationships dialog box is displayed allowing you to make any 
necessary changes.  No changes need to be made at present. 
 
 Click the Cancel button to close the dialog box 

To delete a relationship: 

    Ensure that the relationship is selected 

    Press the Delete key 

A warning is displayed: 

 

    Selecting Yes will complete the deletion 
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 Click the Save icon on the Quick Access Toolbar to save the relationship 

 Ensure that the Relationship Tools’ Design tab is selected 

 Select the Close button to close the Relationships window 

 

If the relationship was not saved, the following reminder is displayed: 

 

●  Confirm that you want to save the changes 
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WORKING WITH TABLES 
 
 

ENTERING DATA 

 
Entering data is straightforward but, obviously, if the database is to work 
properly, the data must be input into the correct designated fields. 
 
The records are written to the database file as they are entered.  The order in 
which records are input is not important, as information can be selected and 
sorted into any order when reports are being produced. 
 
Do bear in mind that, once you set up a relationship between tables, the rules of 
that relationship apply.  For example, you have created a relationship between 
tblCourses and tblStudentDetails based on the courseNumber field, and you have 
chosen to ‘enforce referential integrity’. 
 
You will find that, because of this, you must enter the data into tblCourses first. 
This is because the ‘enforce referential integrity’ option will validate the 
courseNumber data entered into tblStudentDetails and will not allow any student 
to be enrolled onto a course that does not exist in tblCourses. 
 
To open the Courses table: 
 
 Double-click tblCourses in the Navigation Pane on the left 

The tblCourses table opens in datasheet view ready for data entry. 
 

 
 

If a Field List window is displayed on the right, close it by clicking on the cross. 
This will provide extra space to display the table. 

 

 
 In the Course Number field type PT765800 

 Press the Tab key to move to the next field  

 In the Course Title field type Advanced Pyrotechnics 
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Notice that the column is not wide enough to display all of the information.  Do 
not worry about this – the data is stored even though you cannot see all of it. 
You will learn how to change the column widths shortly. 
 
 Complete this first record with the information below 

Course 
Number 

Course Title 
Room 

Number 
Course 
Leader 

Module 
Credits 

Minimum Number 
of Students 

PT765800 Advanced Pyrotechnics S5.8 Guido Fawkes 5 45 

 
 
 Enter the other records 

Course 
Number 

Course Title 
Room 

Number 
Course Leader Module 

Credits 
Minimum Number 

of Students 

SN765000 Sailing and Navigation H2.5a William Bligh 7.5 20 

TU823000 Trade Unionism and 
Its History 

H6.8 George Loveless 4 25 

 
 
 

CHANGING THE COLUMN WIDTH 

 
When you create a table, columns are set to a default width. 
 
To change the width of the Course Title column: 
 
 Point to the line between the column headings Course Title and Room 

Number 

The mouse pointer changes to  
 
 Double-click the mouse button 

The Course Title column is automatically resized to fit its data. 
 

 
 

Instead of double-clicking, you can click and drag the column to the desired 
width. 

 
Alternatively, you can use the Field Width option in the shortcut menu. 
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To change the width of the Course Leader column: 
 
 Hover the mouse pointer over the title Course Leader and click once to 

select the column 

 Ensure that the Home tab is selected 

 Select More in the Records group of commands  

A list of options is displayed. 

 

 
 Select Field Width 

The Column Width dialog box is displayed. 
 

 
 
 
You have the option to type a new value for the column width or to resize the 
column automatically to the best width for the data by selecting the Best Fit 
button. 
 
 Change the column width to 15 

 Click OK 

Using either of the methods above, ensure that all of the current data, including 
the column headings, are displayed in full. If you add more records later, you 
may need to readjust the column widths. 
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PRINTING A TABLE 

 
Before printing, it is always a good idea to use Print Preview to see how the page 
will look when it is printed. 
 
 Click the File tab 

 Click Print 

 Click Print Preview 

The table is displayed in portrait orientation and you can see that it is too wide 
to fit on the page and so has overflowed on to a second page. 
 

 
 
 

Notice that in Print Preview, only the File and Print Preview tabs are available. 
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 To see both pages, select the Two Pages button in the Zoom group 
of commands 

 
 
To change the page orientation from portrait to landscape so that all of the 
columns are displayed on a single page: 
 
 Click Landscape in the Page Layout group of commands 

The table fits onto one page. 
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 Click the Print button on the ribbon  

The Print dialog box is displayed. 
 

 
 
 Click OK 

The table is printed. 
 
 Click the Close Print Preview button on the ribbon 

You are returned to the datasheet view of the table. 
 
 Close the table 

Further changes were made since you last saved the table, so a pop-up window 
asks if you wish to save the changes to the layout. 
 

 
 
 Click Yes 

Next you will enter the records into the student details table. 
 
 Open tblStudentDetails using the Navigation Pane 

 Enter the records listed on the next page (the Student ID is an AutoNumber so 
the values for this field will be set automatically) 
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Title First name Last name Address line1 Address line2 Town Telephone 

Number 

Date of Birth Driving 

Licence 

Course 

Number 

Mr Francis Tresham 56 Parliament Street Fulham London 2987009 05-Nov-1953 Yes PT765800 

Mrs Roberta Catesby 5 November Road Peckham London  02-Apr-1971 No TU823000 

Mr Thomas Percy Flat 7 Rocket House Birmingham  24-Feb-1968 Yes TU823456 

Mr Christopher Wright Plot 64 Banger Lane London 2652462 13-Apr-1976 Yes PT765800 

 
 
Observe that when you entered the Course Number TU823456 in record number 3, an error message was displayed.  This is 
because Access has checked the integrity of the data and since that course does not exist in the table tblCourses the error 
message is produced. 
 
 Change the Course Number for record number 3 to TU823000 

 Close the Students1 database 

 Open the database Students from the location C:\AccessIntroduction 

If you are using this guide for self-study then you will need to continue with the Students1 database and enter additional data 
before continuing further. 

  Open your Students1 database 

  Open the table tblStudentDetails and enter the data displayed in Appendix 2 (page 123) 
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 Open the table tblStudentDetails 

 Ensure that all of the data is visible 

The table does not need to be saved after adding or editing data, because it 
updates continually and automatically.  However, because you have changed the 
column widths you need to save the table. 
 
 Click the Save button on the Quick Access Toolbar to save the changes 

 
The Navigation Pane on the left can be minimised in order to see more of the 
table. 
 

 
 
 
 Click the Shutter Bar Close Button  

 
 
  

Navigation 
Pane 

Shutter Bar 

Shutter Bar 
Close Button 
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The table fills the window. 
 

 
 
 

To restore the Navigation Pane: 

    Click the Navigation Pane button 

Or 

    Click the Shutter Bar Open Button  

 
 
 

  

Navigation 
Pane 

button 

Shutter Bar 

Open Button 
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SORTING THE DATA 

 
By default the data in the table is sorted on the primary key field, if one has 
been set. 
 
If there is an indexed field but no primary key field in the table, then, by 
default, the data will be sorted on the indexed field. 
 
However, irrespective of whether or not a primary key is set or a field is 
indexed, it is possible to sort the data on any field. 
 
To sort the data by Last Name in ascending order: 
 
 Click into the Last Name column of any record 

 Ensure that the Home tab is selected 

 Click the Ascending button in the Sort & Filter group  

The data is immediately sorted by Last Name. 
 
Once sorted, the table may be saved with the data in this order if desired. 
 
To remove the sort order that you applied to the data: 
 
 Click the Remove Sort button in the Sort & Filter group  

The data returns to the default sort order based on Student ID, since this is the 
primary key field. 
 
 

FILTERING THE DATA 

 
If you have a large table, and you want to view the records for a particular 
course for example, you can narrow the records displayed by creating a filter.  A 
filter simply shows you the records that you want to see and hides the rest. 
 
You want to see only those records for the delegates on course number 
PT765800. 
 
 In the Course Number column, click into a record that displays the course 

number PT765800 

 Ensure that the Home tab is selected 

 Click the Selection button in the Sort & Filter group  
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A list of options is displayed. 
 

 
 
 
 Select Equals “PT765800” 

The data is filtered to show the five records with that course number. 
 

 
 
 
To remove the filter: 
 
 Click the Toggle Filter button in the Sort & Filter group  

All of the records in the table are displayed again. 
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Alternative method for filtering the data to show only the records with 
course number PT765800: 

    Click into the Course Number column for any record 

    Click the Filter button in the Sort & Filter group  

    Click the Select All tick box to remove all ticks 

    Select the PT765800 tick box 

 

    Click OK to apply the filter 

 

Alternative method for removing the filter: 

Notice that next to the navigation buttons at the bottom of the table, the filter 

status button is highlighted and displays the text Filtered  

    Click the filter status button to remove the filter 

The button now indicates that the data is unfiltered.  

 
 
 Close the table 

 Save the changes to the design of the table if asked 
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INTERROGATING THE DATABASE 
 
Once you have entered data into one or more tables, you need to be able to 
interrogate the database to locate the information you require. 
 
A query lets you find the records that you are interested in.  Once the query is 
saved, you can use it to produce a report. 
 
You can create every aspect of a query in design view, or use the Query Wizard 
to guide you through the initial steps. 
 
 

CREATING A QUERY USING THE QUERY WIZARD 

 
A wizard is a sequence of dialog boxes that guide you through a step-by-step 
process.  It will usually provide you with prompts and selectable options. 
 
For this first exercise, you will create a query to find all of the students who live 
in London. 
 
 Select the Create tab 

 Click the Query Wizard button from the Queries group of 
commands 

The New Query dialog box is displayed. 
 

 
 
 Ensure that Simple Query Wizard is selected 

 Click OK 
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The wizard helps you to identify and select the table(s) and field(s) you want to 
use in the query. 
 

 
 
 
 Click the down arrow in the Tables/Queries box 

 
 
 
The two tables in the database are listed. 
 
The information you want to locate is held in the table containing the student 
details. 
 
 Select Table: tblStudentDetails 
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The table is selected and the fields within it are listed. 
 

 
 
 
For this exercise we will choose just a few of the available fields. 
 
 Select title from the Available Fields list 

 Click the  button to move the title field to the Selected Fields box 

 Highlight each of the following fields in turn and click the button to move 
them to the list of selected fields: 

 firstName 

 lastName 

 town 

 telephoneNumber 

 courseNumber 
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To include all of the fields in the query click the         button. 

 
 
 Click the Next button 

The wizard suggests a name for the query. 
 

 
 
 
 Replace the suggested name with qryLondon 

 Click Finish to see the data picked out by the query 

 
 
The fields that you specified are the only ones displayed. 
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MODIFYING A QUERY 

 
You want the query to select the students who live in London.  You therefore 
need to modify the query to pick out only the relevant records. 
 
To modify the query you need to use the design view. 
 
 Select the Home tab 

 Click the Design View icon in the Views group of commands  

The query design grid is displayed. 
 

 
 
 
Have a look at what the boxes in the grid are used for. 
 

 
 

The name of the table 
and the field names 

within it upon which the 
query is based 

 

Field name 

Sort option 

Selection criteria 
Type a word, phrase, or 

expression which the field 
must match 

 

Table name 

A tick means ‘show this field’ 

Optional criteria to match 

Drag the bottom of the box 
downward to see more of 

the fields 
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You want to select the students who live in London. 
 
The town field is the one holding the information that you will use to decide 
which records to choose. 
 
 In the town field, click into the Criteria box and type London 

 
 
If you click into another field you will see that Access automatically encloses the 
text in quotes. 
 
To view the results of this amendment: 
 
 Click the Datasheet View button  

 

The Datasheet View button can be found at the far left of the ribbon when you 
choose either the Home tab or the Query Tools Design contextual tab. 

The results of a query can also be viewed by clicking the Run button which        
is located in the Results group of commands on the Design contextual tab. 

 
 
The resulting list shows only those records where the Town field equals London. 
 

 
 
 
 Click the Design View button to return to design view  
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Logical operators 

 
You can use the operators Or and And to combine criteria. 
 
You use the logical operator Or in a field to find those records where either one 
criterion or another is matched. 
 
To select the students who live in either London or Birmingham: 
 
 In the Or row below “London” type Birmingham 

 

Alternatively you can type “London” Or “Birmingham” in the criteria box. 

 
 

 
 
 
 Click the Datasheet View button to view the results 

 
 
 
 Return to Design View 
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Sorting a field 

 
Next you will sort the results of the query into ascending alphabetical order of 
the Last Name. 
 
 Click into the Sort box of the Last Name field 

 Click the down arrow to see the available choices 

 
 
 Select Ascending 

 
 
 
 Click the Datasheet View button 

 Verify that the records are sorted alphabetically by last name 

 Return to design view 
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Hiding a field 

 
You can hide a field so that it does not show in the results of a query.  You do 
this by removing the tick from the Show box in the field that you want to hide. 
 
 Point to the tick in the town field and click to remove it 

 
 
 
 Click the Datasheet View button 

The results of the query are displayed – the students are shown in alphabetical 
order of last name, and the Town field is not visible. 
 

 
 
 Click the Save button on the Quick Access Toolbar 
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Removing a field 

 
You are going to remove the town field from the query. 
 
 Ensure that you are in design view 

 Point to the town field’s column selector (the narrow grey box at the top of 
the field) 

 
 
As you point at this area, the mouse pointer changes to  
 
 Click once to select the field 

 
 
 
 Press the Delete key 

The field is removed from the query but not from the underlying table. 
 
 View the results of the query 

The students are shown in alphabetical order of last name, since that criterion is 
still set in the query. 
 
However, because the town field has been deleted, the ‘London or Birmingham’ 
criteria have also been deleted from the query.  Therefore all of the records are 
now displayed. 
 
  

Column  selector 
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Adding a field 

 
You will add the Date of Birth field to the query. 
 
 Ensure that you are in design view 

 Double-click dateOfBirth from the list of fields shown in the top section of 
the Design window 

The field is added to the grid in the next available column. 
 

 
 
 
 
Moving a field 

 
You are going to move the courseNumber field, so that it is the first field in the 
query. 
 
 Click the column selector box above the courseNumber field 

The field is selected. 
 
 Point to the column selector box again 

The mouse pointer changes to a white arrow  
 
 Click and hold down the mouse button 

 Drag the courseNumber field to the left along the grid 

As you move the field, a bold vertical line appears between two fields on the 
grid.  This shows you where the field would be positioned if you released the 
mouse button. 
 
 Release the mouse button when the vertical line reaches the far left of the 

grid 
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 View the result in datasheet view 

 
 
 
 
Saving a query under a new name 

 
You are going to save a copy of this query under a different name. 
 
 Select the File tab 

 Click Save Object As 

 
 
 
 In the Save As dialog box, delete the suggested name and type qryLastName 

 Click OK 
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Sort order 

 
You may want to view the data sorted into groups.  For example, you could have 
a sorted list of last names grouped by course number.  In this case you would 
sort on two fields: Course Number and Last Name.  If there is a possibility of 
several students with the same last name, it would be a good idea to also sort on 
the First Name field. 
 
You need to ensure that the first field that you want to sort by is positioned to 
the left of the second field you want to sort by on the query design grid. 
 
 Select the Home tab 

 Ensure that you are viewing qryLastName in design view 

You have already set Sort Ascending on field: lastName.  You have also moved 
the courseNumber field so that it is the leftmost field on the grid. 
 
 In the Sort box of the field: courseNumber, select Ascending 

 Move the field: lastName so that it is to the left of the field: firstName 

 In the Sort box of the field: firstName, select Ascending 

 Hide the other fields so that only courseNumber, lastName and firstName will 
be displayed 

 View the result 

 
 
 Save the query 

 Close the query 
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CREATING A QUERY WITHOUT THE WIZARD 

 
You will use both tables to produce a query that locates those students whose 
course leader is William Bligh. 
 
For this example, instead of using the wizard you will create the query in design 
view. 
 
 Select the Create tab on the ribbon 

 Click the Query Design button in the Queries group of 
commands  

The query design grid is displayed. 
 

 
 
 
The first requirement is to use the Show Table dialog box to specify which 
table(s) or query(s) you want to base this new query on.  In other words, where 
are the fields that you require? 
 
 Select tblCourses  

 Click Add 

As each table is chosen it is added to the query window. 
 
 Select tblStudentDetails  

 Click Add 

 Click the Close button to close the Show Table dialog box 
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Once you have added the tables to the query, you can then select individual 
fields from each table to define the criteria for the query. 
 

Adding field names to the grid 

There are several ways of adding field names to the grid: 

    Double-click an individual field name 

Or 

    Click on a field name and, using the mouse, drag it to the grid 

Or (if you want to use all of the fields in the query) 

    Double-click on the title bar of the table, then click the selected field names 
.     and drag them all on to the grid together 

 
 
From the tblStudentDetails list of fields: 
 
 Select firstName and add it to the grid 

 Select lastName and add it to the grid 

 
From the tblCourses list of fields: 
 
 Select courseTitle and add it to the grid 

 Select courseLeader and add it to the grid 
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 In the courseLeader Criteria box, type William Bligh 

 
 
 
When you click outside of the criteria box Access automatically encloses the text 
in quotes. 
 
 View the result 

 
 
 
You can see that the information has been taken from both tables and combined 
to produce the required result. 
 
You will be adapting this query later to allow you to select any course leader and 
see the students who are on the course for which that course leader is 
responsible. 
 
 Save the query with the name qryBligh 

 Close the query 
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CHANGING THE NAVIGATION PANE VIEW 

 
You can change what is displayed in the Navigation Pane and the way in which 
the objects are arranged. 
 
 If the side Navigation Pane is minimised, click the Navigation Pane button to 

restore it 

The Navigation Pane shows a list of all tables with their related queries. 
 

 
 
The query qryBligh takes data from both of the tables so is related to both.  
Therefore, in this view, it is listed under both tables.  This can sometimes cause 
confusion so you will change the view in the Navigation Pane. 
 
To change the way that the objects are arranged: 
 
 Click the down arrow on the Navigation Pane’s title bar 

 
 
 
Notice that in the Navigate To Category options the current selection is Tables 
and Related Views 
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 Select Object Type 

The Navigation Pane now shows the names of all the database objects grouped 
according to the object type. 
 

 
 

 

If the Navigation Pane is only showing a list of tables, then follow these steps to 
display the queries also: 

     Click the down arrow on the title bar of the Navigation Pane 

 

     Choose All Access Objects from the Filter By Group options 
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COPYING A QUERY 

 
Sometimes it is much easier and quicker to create a new query by copying an 
existing one and modifying it. 
 
For the next exercise you are going to create a new query by copying qryBligh. 
 
 Select qryBligh in the Navigation Pane 

 Click the Copy button in the Clipboard group of commands on the 
Home tab  

To paste the copy into the same database: 
 
 Click the Paste button in the Clipboard group  

 
Access suggests a name for the query. 
 

 
 
 
 Delete the suggested name and type qryDates 

 Click OK 

The query is added to the list. 
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 Open qryDates in Design View (right-click on qryDates and select Design 
View) 

 Delete the courseTitle and courseLeader fields and add the dateOfBirth 
field 

 Drag the dateOfBirth field so that it is the leftmost field in the grid 

You will be setting criteria on the dateOfBirth field, but before you do that 
there are some things worth noting about querying a date field. 
 
 

USING DATES IN A QUERY 

 
When you set up a date field in a table, you have the option of displaying the 
date in several different formats. 
 

 
 
It is important to remember that choosing a date format does not change the 
way that Access stores the date, nor does it stipulate the way in which the date 
must be entered into the database.  It just affects the way the date is displayed. 
In other words, Access shows you the date in the format you choose to see it. 
 
The way that Access stores dates means that retrieving data is not quite as 
straightforward as, say, entering criteria in a text field.  We do know, however, 
that the format is numeric – the month names, for example, are only part of the 
field format. 
 
What follows are examples of common criteria that you can use when selecting 
dates. 
 
Selecting a specific date 

 
If you know the exact date you are looking for, you simply type it in the Criteria 
box enclosing it in hashes (#). 
 
 In the Criteria box of the dateOfBirth field, type #05/11/1953# 
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It is also possible to type the criteria as 5/11/53 then click into a different cell. 
Access recognises the criteria as a date and puts the hash marks in 
automatically. 

 
 
 View the result 

 
 
 
You can use the greater than (>) and less than (<) symbols in the criteria. 
 
For example, to find the students who were born after 5 November 1953: 
 
 Amend the criteria to >#05/11/1953# 

 View the result 

 
 
 
However, note that you cannot, for example, type ‘1953’ to find all students 
born in that year, because all parts of the date must be included in the criteria. 
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Selecting a range of dates 

 
You use the ‘Between…And’ operator to specify a range of dates. 
 
 Amend the criteria to Between #05/11/1953# And #24/02/1968# 

 
 
 

If you cannot see all of the text in the box, drag the border to make it wider. 

 
 
 View the result 

 
 
Six records satisfy the given criteria. 
 
Note that ‘Between #05/11/1953# And #24/02/1968#’ means ‘from 5/11/1953 to 
24/2/1968 inclusive’. 
 
 
Using expressions to query a date field 

 
It’s easy to assume that the date format will always be shown as dd/mm/yy. 
However, the default date format specified within Windows is mm/dd/yy. 
 
If the regional settings on the computer you are using are set to English (United 
States) rather than English (United Kingdom), you could accidentally select 
incorrect records. 
 
To overcome this problem, you use functions to select individual parts of a date. 
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 Delete the criteria in the dateOfBirth field 

As the date is divided into three parts (day, month, year), Access has built-in 
functions: Day(), Month(), and Year() that can be used to pick out any one of 
these three components of a given date. 
 
You are going to find students who were born prior to 1970, so will need to use 
the Year() function to select the year component from the rest of the date. 
 
You also need to identify the field that holds the date. 
 
 In the first blank column, type Year([dateOfBirth]) in the Field box 

 
 
 
Observe that the field name dateOfBirth is enclosed within two different types 
of brackets.  Access uses square brackets [ ] to signify that what is within them 
is a field name.  This then goes within parentheses ( ) to indicate that it is to be 
taken as the parameter of the Year() function. 
 
 Click away from the cell 

Access gives the field a default name by adding the text Expr1: 
 

 
 
 
 In the Criteria box of the Expr1 field type <1970 
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 View the result 

 
 
 
Notice that the field name is shown as Expr1.  To change this name: 
 
 In Design view, delete Expr1 from the field box  (do not delete the colon (:)) 

 Type Year instead 

 
 
 View the result 

 
 
The field now has an appropriate name displayed in datasheet view. 
 
 Return to design view 

 Delete the criteria from the Year field 
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 In the next empty column type Month:Month([dateOfBirth]) in the field box 

 In the Criteria box for this field type 5 Or 6 

 
 
 
 View the results of the query 

 
 
 
 Return to design view 

 Delete the criteria from the Month field 

 In the next empty column type Day:Day([dateOfBirth]) in the field box 

 In the Criteria box for this field type 26 

 
 
 
 View the results 

 
 
 
 Save and close the query 
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USING A CALCULATED FIELD 

 
A database table is designed simply to hold data, and it is not possible to 
perform a calculation in a table.  However, you can use a query to find totals, 
averages, minimum or maximum values in the records that the query has 
identified, and you can then include these values in a report. 
 
You are going to create a calculated field which will multiply the minimum 
number of students by the module credits. 
 
 Create a new query in design view 

 Add the tblCourses table to the query design grid 

 Add the moduleCredits and minimumStudents fields to the grid 

 Click into the next empty Field cell on the grid 

 Type moduleCredits*minimumStudents in the Field box 

 Click into another cell 

Access adds the default name Expr1 to the column and puts square brackets [ ] 
around each of the field names. 
 

 
 
 
 Delete the default name Expr1 and type Total in its place 

 View the result 

 
 
 
 Save the query with the name qryCalculated 

 Close the query 
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FORMS 
 
There are different types of forms, including Detail forms, Split forms, Sub 
forms, and Navigation forms.  This course deals mainly with Detail forms.  A 
Detail form is used to enter, edit, or display data from a table or query.  Instead 
of opening a table to view data, you can design a form that spreads the data out 
on the page, or limits the number of fields displayed. 
 
It is also much easier to enter data into a form rather than into a table, 
especially when the form is designed to show one record at a time. 
 
 
 

CREATING A STANDARD DETAIL FORM 

 
Access can automatically create a standard form that includes all the available 
fields.  All you need to do is indicate which table or query you want the form to 
be based on. 
 
 Click the tblStudentDetails table in the Navigation Pane to select it 

 Select the Create tab 

 Click the Form button in the Forms group of commands  

A form is created based on the selected table. 
 

 
 
 
 Click the Save button on the Quick Access Toolbar 
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 Delete the suggested name and type frmStudents 

 
 
 Click OK 

 In the Views group of commands on the ribbon, click the bottom half of the 
View button 

Observe that three different views are available for a form object. 
 

 
 
Form View is used to interact with the data.  In this view you can view the data, 
edit existing records and add new records. 
 
Design View, like in the previous objects discussed, is used to edit the design of 
the form.  It enables you to change the formatting and to reposition, resize, 
delete or add different controls to the form.  In addition, Design View is used to 
customise other aspects of the form. 
 
Layout View is an intermediate view between Form View and Design View.  This 
view closely resembles the Form View and displays the data, but you cannot 
interact with the data.  The purpose of this view is to enable you to make 
changes to the layout of the form and see immediately how the changes affect 
viewing the data.  It is therefore ideal for changing the size of the fields to 
ensure that all data is displayed, but it also enables you to remove or add fields 
to the form, re-order the fields and edit the title of the form. 
 
 Select Form View 
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Using the navigation buttons 

 
The form shows the information in the first record of the table 
tblStudentDetails. 
 
The navigation buttons at the bottom of the form enable you to view and edit 
other records. 
 
 
 
 
 

  
 
 
 
 
 Scroll through the first few records by clicking    a few times 

 Click    to move directly to the last record 

 Click    to move to the first record 

 Click into the box showing 1 of 17 

 Delete the current number 

 Type 14 and press Enter 

The form displays record 14. 
 
 
To edit the displayed record you click into the appropriate field (or use the tab 
key to move to the field) and make the necessary change to the data. 
 
 Make the following changes to record 14: 

Title:  Mrs 
Last Name: Jones 

 Click the    button to create a new record (see the diagram above) 

 Add the following three records using the form: 

Ms Beryl Hollins 32 New 
Street 

 Rochester 2540874 23/10/62 No TU823000 

Mrs Celia Blair 8 Plain 
Walk 

Fulham London 2987431 10/03/50 Yes PT765800 

Mr Jason Armitage 99 
Fairview 
Way 

 Dundee 2396566 13/12/74 No PT765800 

 

Move to the 

first record 

Move to the 

last record 

Move to the 
previous record 

 

Move to the 
next record 

 

Create a new record 
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Applying a filter in a form 

 
You can add a filter to a form so that you see only those records that fit a 
particular criterion. 
 
 Click    to return to the first record 

 Click into the Course Number field 

 Ensure that the Home tab is selected 

 Select the Selection button in the Sort & Filter group of commands 

 Choose Does Not Equal “PT765800” 

The filter is applied, filtering out all records with course number PT765800 and 
therefore only showing records with a different course number. 
 

 
 
A button at the bottom of the form reminds you that you are viewing a filtered 
set of records. 
 
 Scroll through the records 

To remove the filter: 
 
 Click the Toggle Filter button in the Sort & Filter group of 

commands  
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Finding a record 

 
You use the Find command to search for a particular record. 
 
To find the record for Jacqueline Loveless, since Jacqueline is stored in the First 
Name field and Loveless is in the Last Name field, you can use either of these 
fields and search for the corresponding part of the name. 
 
To search for the Last Name: 
 
 Click into the Last Name field of the current record 

 Ensure that the Home tab is selected 

 Select the Find button in the Find group of commands  

The Find and Replace dialog box opens. 
 
 In the Find What box type Loveless 

 

 
 
 
Observe that ‘Current field’ is the option displayed in the Look In box, so it is 
necessary to first select the field that you wish to search. 
 
 Click Find Next 

The first record that meets the criterion you selected is presented. 
 
As this is the correct record: 
 
 Click Cancel to close the dialog box 

 Amend Address line1 to 3 Farm Cottages 

 Amend the Telephone Number to 2786310 
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Printing a record 

 
To print this record, you need to select it. 
 
 Click on the selection bar to the left of the record details 

 
 
 Click the File tab to display the file management tools 

 Click Print 

 
 
 Select Print from the list of options 

Click here to 

select record 
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The Print dialog box is displayed. 
 
 In the Print Range section, choose Selected Record(s) 

 

 
 
 Click OK 

The record is printed. 
 
 
Deleting a record 

 
 Find the record for Thomas Percy 

 Click on the selection bar to the left of the record details 

 Press the Delete key 

Access shows you a warning message requiring you to confirm that you do want 
to delete the selected record. 
 

 
 
 
 Click Yes 

The record is deleted. 
 
 Display the first record in preparation for the next section 
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MODIFYING A FORM IN LAYOUT VIEW 

 
 In the Views group of commands on the Home tab click the bottom half of 

the View button 

 
 
 Select Layout View 

The form is shown in layout view and a Field List pane is also displayed. 
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Deleting a field 

 
You have decided that you do not need to see the Student ID number on the 
form. 
 
 Ensure that the Student ID field is selected on the form 

 
 
 
 Select the Form Layout Tools Arrange tab 

 Click Select Row in the Rows & Columns group of commands  

 
 
The data is arranged in a table structure and this selects a row in the table. 
 
 Press the Delete key 

The Student ID row is removed and the other rows move up. 
 

Student ID field 
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 Delete the Town field from the form 

Inserting a field 

 
To insert the Town field into the form: 
 
 Double-click town in the Field List 

The field is inserted at the bottom of the form. 
 

  
 

Label 

Text box 

Double click 
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Notice that two boxes are inserted into the form.  The box on the right contains 
data from the field and is called a text box.  The box on the left contains a 
description of the data that is being displayed and is called a label.  The text for 
the label is taken from the Caption property of the field if one is set, otherwise 
the label will display the field name. 
 
By default the label is linked to the text box and both can be manipulated at the 
same time. 
 
You will see later that all the text boxes can be modified together and all the 
labels can be modified together. 
 

Displaying and Hiding the Field List 

●  Select the Form Layout Tools Design tab 

The Add Existing Fields option in the Tools group of commands  

is used to toggle the Field List On and Off. 

●  Click Add Existing Fields  

If the Field List was displayed, it would now be hidden. 

●  Click Add Existing Fields again 

The Field List is displayed once more. 

 
 
 Hide the Field List to display the full form 
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Changing the order of the fields 

 
To position the Town field immediately below Address line2: 
 
 Point to the newly inserted text box 

 Hold down the left mouse button and drag upward 

As you move the mouse upward, a horizontal line moves up the list of fields. 
 
 When the line reaches the point between Address line2 and Telephone 

number, release the mouse button 

Both the label and text box are moved to the new position. 
 

 
 
 
 
Editing the form heading 

 
The name of the form was inserted at the top as a default heading.  You will 
change the heading to something more suitable. 
 
 Ensure that you are still in layout view 

 Double-click the heading tblStudentDetails 

 Edit the heading to Student Details 

 Press Enter 
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The orange rectangle around the heading indicates that it is still the selected 
item. 
 
 Select the Form Layout Tools Format tab  

Using the Font group of commands, 
 
 Change the font and size to Arial 26pt 

 Change the font colour to a colour of your choice 

 

Editing the format of the displayed data 

 
 Click the title field text box to select it 
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 Move the mouse pointer just above the highlighted text box so that the 

pointer changes to a black down-arrow  and click the mouse button 

All the text boxes for the fields are selected. 
 

 
 
 
 Change the font and size to Trebuchet MS 16pt 

 Click the title field label to select it 

 

 
 
 
 Move the mouse pointer just above the highlighted label so that the pointer 

changes to a black down-arrow  and click the mouse button 
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All the labels are selected. 
 

 
 

 Click on the Align Text Right button  

 Click on a blank area of the form to deselect the labels 
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Resizing text boxes 

 
The text boxes displaying the data from the fields are unnecessarily long. 
 
To reduce the width of the text boxes: 
 
 Click in the title field text box to select it 

 Move the mouse pointer to the right-hand border of the selected text box 

The pointer changes to a double arrow   
 

 
 
 Hold down the left mouse button and drag the border to the left 

(drag to approximately half the original width) 

 Release the mouse button 

The text boxes for all the fields are resized to the new smaller width. 
 
 View the form in form view 

 
 
 
 Save and close the form 
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SPLIT FORMS 

 
Access will automatically create a split form if the table selected has a one-to-
many relationship with another table. 
 
 Click the tblCourses table in the Navigation Pane to select it 

 Select the Create tab 

 Click the Form button in the Forms group of commands 

A form is created based on the selected table. 
 
 Save the form with the name frmCourses 

The table tblCourses is linked to tblStudentDetails with a one-to-many 
relationship where each course is linked to many student records.  Access 
therefore creates a split form. 
 

 
 
 
 
The top part of the form looks similar to the detail form created earlier and 
displays data from one record in tblCourses. 
 
The second part of the form displays data from tblStudentDetails.  The records 
shown are the students who have enrolled on the displayed course. 
 
 Use the navigation bar at the very bottom of the form window to scroll 

through the three courses 

 Close the form 

Use this navigation bar to scroll through the courses 
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 CREATING A FORM USING THE FORM WIZARD 

 
Access has a wizard that walks you through the process of creating a form.  You 
will use this method to create the next form. 
 
A form can be based on either a table or a query.  Basing a form on a query 
restricts the display to the records and fields picked out by the query. 
 
This next form will be based on the qryBligh query and will demonstrate that by 
changing the query, you also change the records that you see in the form. 
 
 Select the Create tab 

 Select the Form Wizard button from the Forms group of 
commands  

The Form Wizard opens. 
 

 
 
 
 In the Tables/Queries box, select Query: qryBligh 
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 Using , move all the Available Fields into the Selected Fields box 

 
 
 
 Click Next to accept the selected fields 

 Click Next to accept the default layout  

 In the What title do you want for your form? box, delete the suggested 
name and type frmBlighStudents 

 Click Finish 

The completed form is displayed. 
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Using a parameter in a query 

 
The present form is based on the qryBligh query which searches for students who 
have William Bligh as their course leader. 
 
You are going to return to the query and amend it so that it can be used to pick 
out the students for any of the course leaders. 
 
 Close the form 

 Open the qryBligh query 

 In design view, delete the criteria “William Bligh” from the courseLeader 
field 

 Replace it with the text [Enter the course leader] 

 
 
 
This ‘parameter query’ is useful in that it lets you specify the criteria the query 
will use to find the records when the form is opened. 
 
 Click the Datasheet View button 

You are asked to enter the parameter value. 
 

 
 
You can see that the text that you included in the square brackets is displayed 
as a reminder of the information you need to enter in this box.  Without this 
prompt, it would be difficult to remember exactly what you are expected to key 
in. 
 
 Type Guido Fawkes 

 Click OK 
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The records for Guido Fawkes are displayed. 
 

 
 
 Save and close the query 

 Open frmBlighStudents 

As this form is based on qryBligh, any amendments you make to the query are 
reflected in the form, therefore you are asked to enter the name of the course 
leader whose records you wish to view. 
 
 Type George Loveless 

 Click OK 

Only the records relating to George Loveless are shown. 
 
 Scroll through the records 

 Change the form heading to Course Bookings with a font size of 36 

 Save and close the form 
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REPORTS 
 
You use a report to present data in a format more suitable for printing.  You 
have control over everything you see on a report and so may customise it to your 
own requirements.  You can create a variety of reports in Access ranging from 
the very simple to the very complicated. 
 
A report also lets you summarise data, so you can, for example, not only list all 
of the students enrolled on a course, but also have the report print a total. 
 
 

CREATING REPORTS USING THE REPORT WIZARD 

 
You are going to produce two reports using the wizard.  Both will list the 
students by courses.  The first will be based on a query which must now be 
created. 
 
 Using the Query Wizard, create a new query containing the following fields: 

Table: tblCourses 
courseTitle 
 
Table: tblStudentDetails 
firstName 
lastName 
dateOfBirth 
 

 Save the query with the title qryCoursesInfo 

 Close the query 

You are now ready to create a report based on this query. 
 
 Select the Report Wizard button from the Reports group of 

commands on the Create tab 

 In the Tables/Queries box, click the down arrow and select Query: 
qryCoursesInfo 
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 Move all the Available Fields into the Selected Fields box 

 Click Next 

This step in the wizard asks you to specify how you want to view the 
information. 
 

 
 
The pane on the right shows you an example of how the fields will be laid out on 
the report, depending upon whether you choose ‘by tblCourses’ or ‘by 
tblStudentDetails’. 
 
 Ensure that by tblCourses is selected 

 Click Next 

 Ignore the grouping prompt and click Next 

The records can be sorted in ascending or descending order. 
 
You will sort the students into alphabetical order of last name. 
 
 Click the down arrow to select the first field to be sorted 
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 Select lastName 

 Select firstName as the second field to be sorted 

 
 
 Click Next 

 
 
This step asks you about the report layout.  Notice the tick box that provides the 
option to adjust the field width so that all fields can fit on the page. 
 
 Click Next 

The wizard suggests a title for the report. 
 
 Change the title to rptCourses 

 Click Finish 

The report is displayed in Print Preview. 
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To close the print preview: 
 
 Click the Close Print Preview button  

The report is displayed in Design View. 
  

 
 
 Close the report 
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Including summary data in a report 

 
In the previous exercise, you created a query to use as the record source before 
using the report wizard. 
 
For this exercise, you will select fields directly from the two tables as you 
proceed through the wizard. 
 
 Start the Report Wizard 

  From Table: tblStudentDetails select the fields: 

firstName 
lastName 

 
 From Table: tblCourses select the fields: 

courseTitle 
moduleCredits 
minimumStudents 

 

 
 
 Click Next 

 View the data by tblStudentDetails 

 Click Next 

 For group levels select courseTitle 

 Click  
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 Click Next 

 Sort by lastName 

 
 
 
‘Summary Options’ enable you to include totals and averages on your report, for 
fields that contain numerical data. 
 
 Click the Summary Options button 
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The Summary Options dialog box is displayed. 
 
All the numeric fields that you selected are listed in the dialog box. 
 

 
 
 
 For the field moduleCredits select Sum 

 For the field minimumStudents select Avg 

 Ensure that Detail and Summary is selected in the Show section 

 
 
 
 Click OK 

 Click Next 

 Accept the default layout and orientation.  Click Next 

 Change the report title to rptSummaryInfo 

 Click Finish 
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The report is created and opened in Print Preview. 
 
 In the Zoom group of commands, click the One Page button 

The text may be too small to be read, but you can see what the layout of the 
entire page looks like. 
 

 
 
 
 Click the bottom half of the Zoom button in the Zoom group of commands 

 
 
 
 
 
 
 
 
 Select Zoom 100% 
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MODIFYING A REPORT IN LAYOUT VIEW 

 
There will usually be a few modifications that you will want to make to your 
reports. 
 
 Close Print Preview 

The report is displayed in Design View. 
 
 In the Views group of commands on the ribbon click the bottom half of the 

View button 

There are four different views available for a report object: 

                          
 
Similar to editing forms, you make changes to reports in Layout view or Design 
View.  There are some changes that you will make in Design View, but first you 
will look at Layout View. 
 
 Select Layout View 

To provide more working space: 
 
 Minimise the Navigation pane 

 Close the Field List pane 

 
Editing labels and text boxes 

 
To edit the courseTitle label: 
 
 Double-click the courseTitle label (heading) 

 
 
 Change the heading to Course Title 

 Change the title at the top of the report to Summary Information 
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To change the text Avg on the report: 
 
 Double-click the text Avg for any of the three courses on the report 

 
 
 Replace Avg with the words Average number of students 

 Press Enter 

All the Avg labels display the text that you typed. 
 

 
 
 Scroll down to the bottom of the report 

The Grand Total at the bottom will stand out better if it is separated from the 
other information. 
 
 Click on the text Grand Total 

 Hold down the Shift key and click the grand total value (104) 

The Grand Total label and text box are both selected. 
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 Point to one of the selected boxes, hold down the mouse button and drag the 

boxes downward to leave a larger gap below the other text, and then release 
the mouse button 

The Grand Total now stands apart from the other information. 
 

 
 

Alternatively 

The arrow keys on the keyboard may be used to nudge labels or text boxes in 
any direction. 

 
A larger gap between the different group lists would improve the design. 
 
 Select one of the course titles text boxes (eg Sailing and Navigation) 

 Use the down arrow key repeatedly to nudge the text boxes downward until 
you are satisfied with the look 

By default numerical values are right aligned in text boxes.  To centre align the 
Module Credit values: 
 
 Select any one of the Module Credit text boxes 

All the Module Credit text boxes are highlighted. 
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 Select the Report Layout Tools Format tab 

 Click the Centre Align button in the Fonts group of commands 

The values are centred in the text boxes. 
 

 
 
 Centre align the other numerical values on the report 

 Save the changes to the report 

 
Removing and Inserting page numbers 

 
A page number in the format page n of m was inserted in the report’s footer by 
default.  You will delete this and replace it with a page number in the format 
page n. 
 
 Scroll down to the bottom of the report 

 Click the text Page 1 of 1 to select the text box 

 
 
 Press the Delete key 

The page number is removed from the report. 
 
To insert a replacement page number: 
 
 Select the Report Layout Tools Design tab  

 Click Page Numbers in the Header / Footer group of 
commands  

The Page Numbers dialog box is displayed. 
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 In the Format section, ensure Page N is selected 

 In the Position section, select Bottom of Page [Footer] 

 In the Alignment section, click the down arrow and select Right 

 
 
 Click OK 

A page number with the selected format is inserted into the footer of the report. 
 

 
 
The new page number is not in line with the date.  You will use the alignment 
tool in Design View to fix this. 
 
At present the report shows the average number of students for each course 
separately.  However you want to display the average for the whole report. 
 
This type of modification will have to be done in Design View also. 
 
 Save the changes to the report 
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MODIFYING A REPORT IN DESIGN VIEW 

 
 Click the bottom half of the View button on the Design tab 

 Select Design View 

 
 
At first glance this looks very complicated and bewildering.  Notice, however, 
that the design is split into various sections: Report Header, Page Header, 
courseTitle Header, Detail, courseTitle Footer, Page Footer and Report Footer. 
 
 Switch between design view and report view a few times and try to identify 

which part of the report each section of the design produces 

Aligning control boxes 

 
There are two text boxes in the Page Footer area.  The one on the left produces 
the date and the one on the right produces the page number. 
 

 
 
 
 
You want the page number to be horizontally in line with the date. 
 
 Click in the date text box to select it 

 Hold down the Shift key and click in the page number text box 

Produces the date Produces the page number 
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Both text boxes are now selected. 
 

 
 
 Select the Report Design Tools Arrange tab 

 Click the Align button in the Sizing & Ordering group of commands 

 
 
 Select Bottom 

The higher of the two text boxes moves down so that the bottom borders align. 
 
Moving summary information 

 
You will now edit the report to display the average number of students for the 
whole report instead of showing it for each group. 
 
The label and text box for the average number of students are located in the 
courseTitle Footer section.  In other words, the footer for each course title.  
This therefore produces an average value for each course title group. 
 
To show an average value for the whole report, you need to move the 
appropriate label and text box into the Report Footer section. 
 
 Click Average number of students to select the label 

 Hold down the Shift key and click =Avg([minimumStudents]) to select the 
text box 

Both label and text box are selected. 
 

 
 
 Move the mouse pointer over one of the selected boxes 
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 Hold down the left mouse button and drag downward 

 Release the mouse button when the Average number of students label is just 
above the Grand Total label in the Report Footer 

 
 
To vertically align the two labels in the footer: 
 
 Select the Grand Total label 

 Hold down the shift key and select the Average number of students label 

 Click the Align button on the Arrange tab 

 Select Left 

You will make the footer information more readable by moving the text boxes 
closer to their respective labels. 
 
 Select the text box that calculates the average number of students 

 Move it to the left so that it is close to the Average number of students label 

 
 
 Select both text boxes in the report footer and align them left 

 
 
 View the report in Report View 

Notice that the value of the average number of students is given to a large 
number of decimal places.  The next section uses Design View to change the 
display to a whole number, but the same method can be used in Layout View. 
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Using the Property Sheet to set formatting and dimensions 

 
To format the average value to display as a whole number: 
 
 Switch to Design View 

 Select only the text box that will display the value of the average number of 
students 

 
 
 Ensure that the Report Design Tools Design tab is selected 

 Click Property Sheet in the Tools group of commands   

The Property Sheet pane is displayed on the right of the window. 
 

 
 
 Check that the All tab is selected 

 Click the Format property in the Property Sheet task pane 

 Click the down arrow for the Format property 
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 Choose Fixed from the list of available formats 

 Select 0 for the Decimal Places property 

 Check in Report View that the value is now displayed as a whole number and 
return to Design View 

To ensure that both text boxes in the Report Footer are the same size you will 
use the Property Sheet to set the dimensions. 
 
 Select both text boxes in the Report Footer 

On the Property Sheet, 
 
 In the Width property type the value 2.8 cm 

 In the Height property type 0.56 cm 

 Press Enter 

Access usually displays dimension values to 3 decimal places. 

You may also notice that the values displayed are slightly different from the 
values that you typed. 

 

This would not be a problem since both boxes are set exactly the same. 

 
 Close the Property Sheet 

 Switch to Report View and scroll to the bottom of the report to see the 
effect of the changes 
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Moving columns 

 
To illustrate how columns of data are moved, you will swap the Last Name and 
First Name columns so that the first names are displayed to the left of the last 
names. 
 
 Display the report in Design View 

The text box for the firstName field and corresponding column label must both 
be moved and must swap places with the text box and column label for the 
lastName field. 
 

 
 
We will first move the lastName field out of the way so that the firstName field 
can take its place. 
 
 Select both the text box and column label for the lastName field 

 Use the left arrow key on the keyboard repeatedly to move the selected 
controls over to the left leaving the original position clear 

 
 
 Select both the text box and column label for the firstName field 

Last Name label First Name label 

Last Name text box 

displays the field values 

First Name text box 

displays the field values 
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 Use the left arrow key to move the selected controls to the position vacated 
by the lastName field 

 
 
 Select the text box and column label for the lastName field 

 Use the right arrow key to move the selected controls to the position vacated 
by the firstName field 

 
 
The swap is now completed. 
 
 Switch to Report View to check the display 

 Save and print the report 

 Close the report 
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CREATING REPORTS AUTOMATICALLY 

 
You saw earlier (page 73) that a form can be created automatically.  Using a 
similar method you can create a simple, table-like report automatically.  All you 
need to do is indicate which table or query the report must be based on. 
 
You will create a report based on the query qryLondon. 
 
 Select qryLondon from the list of queries in the Navigation Pane – there is no 

need to open the query 

 Select the Create tab 

 From the Reports group of commands, select Report 

After a short delay, a report is created and displayed in layout view. 
 

 
 
 
 View the report in Print Preview 

 Close the report without saving it 
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PRODUCING LABELS 

 
You are going to create a set of address labels using the Label Wizard. 
 
 Select tblStudentDetails from the Navigation Pane 

The fields from the selected table will be available to the Label Wizard. 
 
 Ensure that the Create tab is selected 

 From the Reports group of commands, select the Labels button  

The Label Wizard is displayed, and you are asked to choose the label size. 
 
 Ensure that Avery is selected as the manufacturer and that the unit of 

measure is Metric 

 Select Product number Avery J8162 

 
 
 Click Next 
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 To accept the text appearance offered, click Next 

You next need to indicate which fields you want to include on the label, and also 
how they should be displayed. 
 

 
 
You want to put the title, first name and last name on the first line with a space 
between each word. 
 
 From the Available fields list, select title and click   

 Press the spacebar once to put a space between the title and the next field 

 Select firstName, click   and press the spacebar 

 Select lastName, click  and press Enter 

 Add address1, address2 and town on separate lines 

 
 
 Click Next 
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To sort by the town field: 
 
 Select town and click   

 
 
 Click Next 

 Accept the default report name 

 Click Finish 

The labels report is displayed with the data in alphabetical order of town. 
 

 
 
 
 Close the report 

 Close Access 
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APPENDIX 1 
 
 

FIELD PROPERTIES 

 
Field Properties are used to determine how Access handles and stores data, for 
example a date.  When you create a field, a list of properties is displayed.  The 
list of properties available is dependent on the data type chosen. 
 
 
Field size 

 
When a field has been specified as a text field, you can adjust the size from 1 to 
255 characters.  When the field is a number, then the following values apply. 
 
Setting Range Decimal Places Storage Size 

Byte 0 to 255 No decimal places 1 byte 

Integer -32,768 to 32,767 No decimal places 2 byte 

Long Integer -2,147,483,648 to 2,147,483,647 No decimal places 4 bytes 

Single -3.4E38 to 3.4E38 Up to 7 4 bytes 

Double -1.797E308 to 1.797E308 Up to 15 8 bytes 

Decimal -9.99E27 to 9.99E27 Up to 28 12 bytes 

Replication ID Unique ID required for replication n/a 16 bytes 

 
 
Format 

 
When using number fields, the data is displayed depending on the property 
chosen. 
 

Display Layout Format General Number 
 How data is entered How data is displayed 

General number 1234.56 1234.56 
Currency 1234.56 £1,234.56 
Fixed (2 places default) 1234.56 1234.56 
Percent 0.1234 12.34% 
Scientific 0.001234 1.234E-3 

   

Date Format   

 How you might enter data How  data is displayed 

General Date 18/4/98 18/04/98 23:39:00 
Long Date 18/4/98 18 April 1998 
Medium Date 18/4/98 18-Apr-98 
Short Date 18/4/98 18/04/98 
Long Time 10.15 10:15:00 PM 
Medium Time 10.15 10:15 PM 
Short Time 10.15 10:15 

 

Text Format   

 How data is entered How  data is displayed 
> >uppercase UPPERCASE 
< <LOWERCASE lowercase 
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Decimal places 

 
With numeric fields you can set the number of decimal places to between 0 and 
28. 
 
If you choose Auto, the number of decimal places will be allocated according to 
the field size. 
 
 
Input mask 

 
Use an input mask to ensure that values entered into a field are in the correct 
format.  The input mask uses a special character to represent each character 
entered into a field. 
 
For example, an input mask of LL0 indicates that a field must contain two letters 
and one number. 
 

Input Mask What it means 
0 Enter a Digit (required) 
9 Enter a Digit (not required) 
#  Digit, + or - sign or space 
L Letter (required) 
? Letter (not required) 
A Letter or digit (required) 
a Letter or digit (not required) 
& Any character or space (required) 
C Character or space (not required) 
.,:;-/ Decimal point, data & time 

separators 
<  Convert characters to lower case 
> Convert character to upper case 
! Fill from right to left 
\ Characters shown as literal 

 
 
Caption 

 
When creating default labels for reports and forms, Access uses the text set in 
the caption property.  If no caption is set, Access uses the field name.  It is 
therefore necessary to set a caption if the field name is not appropriate for a 
label on a report or form. 
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Default value 

 
A default value is the value entered into a field if there is no alternative. 
 
For example, say you are creating a database containing information on car 
drivers.  As a licence is not issued until a person is 17 years old, then the default 
value could be 17. 
 
Date() enters the current date. 
 
 
Validation rule 

 
This property limits the values entered into the field. 
 
For example, a validation rule of “Mr” or “Mrs” or “Miss” or “Ms” would mean 
that only one of these four words would be accepted. 
 
 
Validation text 

 
Used in conjunction with the validation rule.  If the rule is not met, then the 
validation text is displayed as a message to the user. 
 
 
Required 

 
Used on any field to indicate that a value must be entered. 
 
 
Allow zero length 

 
Used with a text or memo field to ensure that an entry appears in every field, 
even if it is left empty by the user. 
 
A value of “” is entered into an empty field.  In this case the Required property 
for this field must be set to ‘Yes’. 
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Indexed 

 
Used on any field to speed up searching the database.  Similar to an index in a 
book, if an indexed field is used in a search or query, Access will search the 
index which is much quicker than searching the whole database. 
 
However, indexing a field will slow down entering and editing data as, not only 
is the data updated, so is the index.  Use indexing wisely to get the best 
performance from your database. 
 

Index setting Meaning 
NO No index 
YES (Duplicate OK) Create an index on this field - there may be 

duplicates 
YES (No duplicates) Create a unique index on this field - no duplicates 

allowed (useful for information such as a National 
Insurance number where there should be one only) 
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APPENDIX 2 
 
The page opposite displays the data needed in the table tblStudentDetails for 
page 42.  This data is saved in the Students database, but if you are working 
through this guide on your own you will need to input this data before 
continuing. 
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Title First name Last name Address line1 Address line2 Town Telephone 

Number 

Date of Birth Driving 

Licence 

Course 

Number 

Mr Francis Tresham 56 Parliament Street Fulham London 2987009 05-Nov-1953 Yes PT765800 

Mrs Roberta Catesby 5 November Road Peckham London  02-Apr-1971 No TU823000 

Mr Thomas Percy Flat 7 Rocket House Birmingham  24-Feb-1968 Yes TU823000 

Mr Christopher Wright Plot 64 Banger Lane London 2652462 13-Apr-1976 Yes PT765800 

Mr Thomas Bates The Big House Bonfire Road Moreton 2295875 21-Jun-1957 Yes SN765000 

Ms Jane Grant Thatched Cottage Hunters Walk Coventry 2862957 16-Aug-1975 Yes PT765800 

Mr William Brown 42 Garden Street  Rothley 2567657 08-Oct-1972 No SN765000 

Mrs Charlene Churchill 78 Arms Lane  Aylesbury 2765890 15-May-1973 Yes TU823000 

Mrs Petronella Haywood Midtown Apartments Pickton Street Manchester 2260900 26-May-1973 No SN765000 

Ms  Mattie Quintal The Cottage Sea Front Lane Poole 2593721 17-Feb-1955 Yes PT765800 

Mr Richard Skinner The Seaman's Arms  Beer 2760174 21-Jun-1965 Yes PT765800 

Mr John Williams Seaside Walk  Frome  28-Feb-1967 Yes SN765000 

Mr Charles Norman Mate's View Carpenter Street Lyme Regis  15-Mar-1969 No TU823000 

Ms Janice Brine 45 Union Way  Conwy 2563780 02-Nov-1946 Yes SN765000 

Mrs Janet Hammett 87a Heroes Walk Chiswick London 2761098 20-Nov-1946 Yes SN765000 

Mrs Jacqueline Loveless Farm Cottages Martyr Street Tolpuddle 2786502 26-Oct-1974 Yes TU823000 

Ms Theresa Stanfield 90 Friend Street  Dorchester 2897656 09-Nov-1981 Yes TU823000 

 


